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Astrophotography 101 Class Index and Appendix List 

 

This is a beginning class to give you an overview of the hardware and software you need for astrophotography. 
What will be covered in the class & What do you need? 
Types of Cameras - Any camera will work! 

Using Film Cameras 
Methods for Still Images - for Digital or Film Cameras 
The “f-number” of the Telescope or a Camera Lens 
Digital Cameras - Canon, Nikon, Sony and others 
CCD (charge-coupled device) 
CMOS (complementary metal-oxide semiconductor) 
Cell Phone Cameras 
Infra-Red, Heat Detecting & Specialty Cameras (A. to F.) 
Spectroscopic Cameras & Home-Made Spectroscope 
Spectroscope Image Viewing & Processing 
Hardware for the Camera 
Black & White, Black & White w/Color Filters & Color Imaging 
Software for Capturing Images and Video 
Techniques for Eclipses, Northern Lights & "Quick" Events 
Urban photography problems and some solutions 

 
Planetary and Deep Sky Photography Demonstration– Terry Dufek 
R2 Demonstration – Rusty Case 

Time to Answer Your Questions! 

 
Appendix A “Using Firecapture”, Terry Dufek 
Appendix B: “Create your own Color Hubble Images”, Zolt Leva (includes Layering Images in Photoshop) 
Appendix C: Astronomical League Reflector, “Three Cheers for the Photosphere”, Jim Daley, Dec 2017 
Appendix D: AL Reflector, “Basic Small-Scope Lunar Imaging”, Jamey L. Jenkins, March 2019 
Appendix E: PAC Reflections, “A solar report from Ken Boquist on March 16th, 2019”, April-2019 
Appendix F: Sky & Telescope, “The Quest for Round Stars”, Ron Brecher, June 2019 
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Welcome to Astrophotography 101 – A Beginning Class on Producing Astronomy Photographs 
 

Please hold all questions until the end of this class! 
Write down your questions in your notebook… 

 

 
 

Your instructors are Dino Milani, Terry Dufek & Rusty Case 
 

The class PDF document can be downloaded from the website https://ncral2019.org/downloads  
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What will be covered in the class 
 

Watch and learn! Review the class with the class download (then review it again and again...) 
Write down your questions. They will be answered at the end of the class. 

 
How to Get Your Shot Dino Milani will instruct you on cameras, mounts, lenses, telescopes, filters, 
software and more 
First Demonstration Terry Dufek will show Planetary and Deep Sky photography methods and 
software 
Second Demonstration Rusty Case will demonstrate the R2 camera 
 

 
 
 
 
 
 
 

Dino Milani   Lunar Eclipse 
4-15-2014                1:30am 
Canon 40D – Manual Mode 
Sigma f-2.8     200mm Lens 

178mm 2.5-Seconds ISO-1600 
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What do you need? 
 

1. A camera to record your photos or videos. 
 
2. A Camera Mount, something to keep the camera steady when taking the image. 

• The steadier the mount the better! 

• It can be a Tripod, Camera Sky Tracker or Telescope Mount. 
 
3. A computer with software to record the image and edit the photo or video. 
 
4. Patience! It takes time and practice to take the shot and to make it look good. 
 
 
 
Suggestions: 

We often leave the photo as a digital image. Try printing the image to see how it looks. 
Keep a journal with your notes and results to see what works. 
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Types of Cameras - Any camera will work! 
 
1. You may record Still Images or Video Recordings. 
 
2. For Still Images you may use Film or Digital cameras, astronomy CMOS or CCD cameras, Infra-
Red, Heat Detecting, Spectroscopic and Cell Phone cameras. 
 
3. For Video Recordings use an astronomy CMOS or CCD camera, a computer Web-Cam, Cell 
Phone cameras or many of the Digital Cameras. 
 
Still Images: 

• Still images can be enhanced and stacked together for a better image. 

• JPEG files are altered by the camera, reduced in size and may also loose clarity so the image is 
not as sharp. 

• It’s best to use RAW formats. They are full sized, keep the color format and easily enhanced. 
 
Video Recordings: 

• The videos can be enhance. Poor frames can be removed and the best frames stacked together 
for a better image. 
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 Using Film Cameras 
 
1. For Fast exposures use a High-ASA film (ASA 400 to 1600). For Long exposures use a Low-

ASA film (ASA 50 to 200). Note: Digital cameras use ISO (International Standards Organization) 
speeds instead of ASA (American Standards Association) speeds. 

• Low ASA produce a better image but take longer to expose the film. 

• High ASA produce an image quickly but there is more “graining” and loss of detail so it’s not 
as sharp! 

2. If possible, use a large-sized negative (only a few photographers have these cameras). 

• Medium format film at 4"x4" or 120mm-120mm. 

• Larger sized film at 8"x10" or 12"x12", etc. 
Note: Traditional methods for Hyper-Enhancing and cooling the film is out-of-date! Kodak stop 
making their high ASA and enhanced films and digital methods have vastly improved the images. 
 

 
 
 
 
 
 
 
 
 

John W. Draper, 1863 12”x12”      Clyde Tombaug’s 13" telescope 
Oldest Photograph of the moon      with 12x12 Film holder 
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Methods for Still Images - for Digital or Film Cameras 
 
1. To see the sky without moving the camera (star trails, northern lights) place the camera on a 
tripod or post and take long exposures, often using “Bulb” mode. Also, you can stack the images to 
see more of the stars rotation or improve contrast in low light areas. 
 

 
Photographer Babak A. Tafreshi, Sky & Telescope. 

Star Trails: Long-Exposure Nightscape Live Webinar, By: Sean Walker  March 29, 2019 
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2. To see a moving object with detail and in good focus you must guide your camera on a 
telescope mount or tracking mount. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rusty Case 5-14-14 
Sony ILCE-3000 

1/160-Second ISO-100 
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3. Use Manual Mode on the camera (film or digital cameras). Normally you should not use the 
other functions (Automatic, Program, Tv, Av, etc.) unless you know their use for a specific image. 
 
4. If using a camera lens instead of a telescope, set the lens aperture to its widest setting. The image 
takes less exposure time and you eliminate seeing the aperture shutters distorting the image (this 
example shows 8 streaks radiating from the star). 

 

  Sirius, from earthsky.org 
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5. If a smaller aperture is needed for a sharper image (i.e., going from f-2.8 to f-8.0) use an 
aperture cover on the end of the camera lens. (Galileo did the same thing on his first telescope!) For 
the cover, you can cut a circular hole in cardboard and tape it to the end of the lens or place it in a 
Cokin holder on the end of the camera lens. Also, small-holed adaptors (instead of cardboard) can go 
into the Cokin holder, as well as color filters for black and white photography. 
 
Cokin P Holder with 70mm Adaptor   38mm Adaptor      Cokin A Holder with 28mm Adaptor in place 
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5. If a smaller aperture is needed (continued) 
 

Aperture Settings of the Camera Lens 

 
The lowest Aperture allows more light to enter for a faster exposure but the focus area is very small 
and, sometimes, details are lost or areas are out-of-focus. Low ISO settings works well. 
A higher Aperture reduces the amount of light entering so the exposure time is increased but the 
focus area is much greater. More details are retained and more areas are in focus. A higher ISO is 
often needed when using a higher Aperture. 
 
Note: The Blue Squares show the amount of light entering the lens. 
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6. Focus Methods 

• Turn Off Autofocus. Always manually focus the camera. 

• Back-and-Forth Focusing – Traditional method. Bring the image close to focus, then past the 
focus, then slowly reverse the direction until the focus returns. (Al Sheidler photo, 46P-Wirtanen) 

  
Close to Focus      Forward to In-Focus 

  
Forward to Out-of-focus    Backward to In-Focus 
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6. Focus Methods (Continued) 

• Bahtinov Focus Mask Filter & Home-Made Focus Filters. Used to produce a better focus, 
for sharper images. Place the Bahtinov mask on the aperture and photograph a bright star. 
Move the focus lever forward and back and take photographs with each move. The distorted 
image will appear aligned side-to-side with the best focus. Various sizes will fit camera lenses 
and most telescopes. 

Note: Home-made versions of the Bahtinov Focus Mask work well. 
 

             
Bahtinov Focus Mask    In Focus    Out of Focus 
 

   Two Home-Made Focus Masks 
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7. Decrease or increase the exposure time for the best image. 

• Faint objects may require 30 seconds to 60 minutes (or more) exposure time. 

• For long exposures, use your watch and time the shot while using “Bulb” mode. 
 
Note: Always choose RAW formats, do not use JPEG. Also, always include a Dark Frame 
photograph, with the lens cap ON, which is used for noise level reduction in the software. 
 
Note: There are older methods for setting the aperture and exposure time on a camera. 
 

Do you remember the “Sunny Day 16” method for daytime photos? 
There’s also the “Looney 11” method for full moons photos. 

 
  Sunny Day 16        Looney 11 

 
 
 
 
  
 

ISO-100 f-11 Speed 1/100 or 1/125 

ISO-200 f-11 Speed 1/200 or 1/250 

ISO-400 f-11 Speed 1/400 or 1/500 
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8. ISO settings: Typical cameras start their ISO at 50 and go to 2400, or higher. Some go to an 
extreme of ISO 102000! 

• Use a Lower ISO for more details and less digital noise but the exposure time is longer. 

• A High ISO will get the image with short exposure time but with more digital noise. 
(see Appendix D: AL Reflector, “Basic Small-Scope Lunar Imaging”, Jamey L. Jenkins, March 2019) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dino Milani 
Lunar Eclipse 1-20-19 1100pm 

f-6.5 6-Seconds ISO-100 
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9. White Balance. Used to set the correct color for the photographed object. 

• For JPEG images, set the White Balance to AWB (Average White Balance) or Cloudy. 

• RAW images allow you to correct the WB in software to better match the objects color. 
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The “f-number” of the Telescope or a Camera Lens 
f-number 

 
To find the f-number (Telescope Length ÷ Aperture) for any lens or telescope: 
Take the Length (total length of tube) divided by the Aperture size (width of lens) = f 
 
Example: A telescope with an Aperture width of 90mm and a Length of 1200mm  

1200 ÷ 90 = f-13.3 
 

 
Note: 

• High f-numbers (f-8 to f-16) means the area in focus is long but more light is needed for the 
image. Stars in that image usually do not show as much trailing as low f-number telescope but 
you need to expose the image much longer and use a high ISO. Autoguiding is often needed. 

• Low f-numbers (f-2 to f-6) means the area in focus is short but the image gets more light in a 
shorter time. Stars do not show trailing unless the alignment is bad. The exposure time is much 
shorter and you can use a low ISO for better details (a sharper image). 
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Digital Cameras - Canon, Nikon, Sony and others 
 

Sensor sizes for still images and video recordings: 
       (Lens Size x Crop = Apparent Size) 
APS-C  16mm-24mm  1.5x-Nikon, 1.6x-Canon crop  
4/3   22mm-18mm  2x crop 
Full Frame   24mm-36mm  no crop     Sony Sensor 
 
"Astro-Enhanced" digital cameras (i.e., Nikon D810A, Canon 6 Da, or others) have their IR filters 
removed from their sensors for better night imaging of reddish colors (hydrogen-alpha nebulosity). 
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CCD (charge-coupled device) 
 
Traditional for video of dim targets with 1/2.7" to 2/3" sensor sizes and with BNC and power 
connections or USB (for both video and power). 
They can be used for video and still images and for Auto Guiding the telescope. 
 

      
ZWO asi120mc-s USB-3 camera   ZWO with filters kit    ATIK camera   
 

       
Starlight Xpress SXVR-H18 w/filter wheel & cooling fan  Starlight Xpress SXVR-H18 w/cooling fan 
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CMOS (complementary metal-oxide semiconductor) 
 
Traditional used on digital cameras. Used for video and still images of dim targets. 1/2.7" to 2/3" 
sensor sizes. Improved CMOS astrophotography camera sensors for still images and videos make 
this a valid camera for your images. They are often a superb camera for planetary, lunar, solar and 
meteor capture videos. Sensor sizes range from 2.99µm to 6.00µm or larger. 
 

    
QHY 5III174 CMOS USB-3  QHYCCD QHY128C Cooled CMOS Color  Celestron NexImage 5-MP Color 
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Sensor Size Comparison 
 

 
 

Image sizes for KAF-8300, KAI-1100 and KAF-16803 sensors. 
(S&T July 2016, Dennis di Cicco, page 65) 

 
 
 

(Image below shows different resolutions.) 
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Cell Phone Cameras 
 
Usually CMOS chips but with quickly changing designs for good results and a very light weigh. 

• They are good for still images and video recordings. 
 
 

 
 
New Sony 48-MP Smartphone Camera 
 
 
 

Celestron NexYZ 3-Axis Universal Smartphone Adapter 
Dial the phone left, right, in or out for the best image. 
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Specialty Telescope 
 

Celestron Rowe-Ackermann Schmidt Astrograph (RASA) with a very low focal length of f-2.2. 
The camera is attached at the front of the telescope. 
Extremely sharp details in the image but with some vignetting when using an APS-C camera, so a 
full frame camera is needed. 
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Infra-Red, Heat Detecting & Specialty Cameras (A. to F.) 

Sometimes expensive, but cool! 

A. Infra Red Filter 
 

An Infra Red Filter can be screwed on the telescope eyepiece (this is the least expensive option). 
 

 
Photographer Jon Greif, April 29, 2017, 2130pm. 

Stellarvue 90mm refractor, QHYCCD MiniCam 5F camera, 
with Methane 12nm narrow band filter centered at 889nm. 
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B. Infra Red, Heat Vision & Night Vision Cameras (A. to F.) 
 
Each camera has different lens and video connections and requires different equipment. 
Your IR images may be small with reduced clarity (not a sharp focus) and with digital noise. 
 

Example: ESA AKARI Telescope, Orion at 140 micrometres infrared wavelength. 
 

 MoviTHERM IRSX Smart Infrared video camera, with 2” telescope adaptor. 
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C. Commercial IR Video Cameras 
 
Inexpensive CCTV (CCD) low-light video camera for night-time or Infra Red images. 
Note: Recordings are usually done using H.264 video compression of the video file. 
 

 Commercial IR Camera with C width threads (lens connection thread size) lens attached. 
 
 

 Commercial IR Camera, 12mm-width threads (lens connection thread size) and 25mm lens. 
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D. Commercial Heat Detecting Cameras 
 

Difficult to connect to the telescope with increased digital noise levels on the images. 
 

    
Larson Heat Detecting 3.1-MP Camera, with WiFi and Bluetooth, reads -40°C to 2,000°C, focuses from 0.45m to Infinity, $59,400. 
 

       
Fluke Heat Detecting Camera, $1,300 to $1,999   
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E. Night Vision Cameras 
 

Also difficult to connect to the telescope with increased digital noise levels on the images. 

   
Flur Thermal Long-wave infrared sensitivity 7.5 - 13.5µm at $2,495 

 

 TNV/TVS Gen3 Pinnacle night vision $2,800 
 
Note: Professional Infra Red, Heat Vision & Night Vision Cameras are expensive and difficult to use 
on your telescope. There are very few available for amateur astronomers. 
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F. Specialty Cameras 
 

 

                                 
 
The Canon ME20F-SH is a multi-purpose camera that utilizes an image sensor and image processing platform developed by Canon to 
achieve a minimum subject illumination of 0.0005 lux1 or less2, the highest sensitivity in the industry3. Even in dark places where it is 
difficult to discern subjects with the naked eye, this camera can make it look like images were captured in broad daylight. The camera 
is used for such applications as nighttime surveillance, natural-disaster confirmation and wildlife-related biological research. 
 
The ME20F-SH, a balance of both has been considered, and the camera uses a resolution of 1,920 x 1,080 ideal for HD video 
recording as well as a large pixel size of 19 x 19 micrometers4. In addition, to ensure that the light that reaches each pixel can be 
converted to electricity without any waste, microlenses are positioned over the pixels to deliver as much light as possible to the 
photodiodes. Note: Canon EF Lens mount. 
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F. Specialty Cameras (Continued) 

From: Sky & Telescope, “Insect Eyes on the Deep Sky”, Richard Wright, Jr. May 2019 
 
The Dragonfly System: This is a multiple-stacked telescope. It has inter-connected hexagonal 
aluminum frames that have a camera lens and camera inside. 24 to 48 frames are stacked together. 
Each frame has a Canon 400mm f-2.8 camera lens ($12,000 each) with an SBIG STF-8300M CCD 
camera, an Intel Compute Stick computer with Windows 10 and TheSky Professional software. The 
Intel computers are them controlled by a central server and the images saved. 
 

   
Image of the 24 stack of cameras (Photos from Sky & Telescope, May 2019, pages 64 to 69.) 
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Spectroscopic Cameras & Home-Made Spectroscope 
 
An alternate is to photos and video is to record the spectrum of suns and planets. 
(see also; Reflector, “Adventures of a Starlight Detective”, Jamey Jenkins, June 2018, pages 14-15.) 
 
 
 
 
 
 
 
 
 

Home-made spectroscope, 500-lines-mm film, 12.5° bend 
          SA 100 Grating Filters can also be used 
 PIXIS Spectroscopic Camera 120 nm to 1100 nm (UV to NIR) 
 
 

 
     Rigel Systems RS-Spectroscope - attach to lens and camera 
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Spectroscope Image Viewing & Processing 
 
Three applications for processing RAW image photographs (do not use JPEG format): 
 

1. Digital Photo Professional (download from Canon): Converts RAW images from Canon’s 
CR2 format to 8-bit TIFF (File, Convert and Save, 8-bit TIFF). 

2. Photoshop: Cropping (Image, Crop), rotation (Image, Rotate Canvas) and skewing (Distort, 
Skew) of the spectrum image. Also use to generation the spectrum continuum image (Blur, 
Motion Blur, 0 degrees, 50 pixels). 

3. ImageJ (freeware): Scale the spectrum continuum image (Process, Math, Multiply by 0.7) and 
then subtract (Process, Image Math, Subtract) from the cropped/rotated/skewed spectral image 
to enhance the spectral lines. 

4. Photoshop: Finally, tweak the contrast (Image, Auto Contrast) of the final spectrum image. 
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Hardware for the Camera 
 
Use a Tripod for non-tracing or a Tracking Mount to track the sky. 
Note: If you wish better polar alignment (and better star tracking) on equatorial tracking mounts, use 
the Pole Master. It will give you a better polar alignment on your telescope. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Tripod    Camera Tracking Mount   Telescope Mount 
(iOptron Sky Tracker)          (Equatorial Tracking) 
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To attach the camera directly to a telescope use a camera T2 Adaptor - with 42mm thread - and a 
Prime-Focus Adaptor or a Tube T-Adaptor - with 42mm thread. 
Note: Astronomy cameras often have a 42mm thread connection. 
 
 
 

 
 
 
        Camera T2 Adaptor        1.25” Tube T-Adaptor 

 
 
 
D-Mount ring with 42mm outside thread, 1” inside thread and 17.5mm back-focus length. 
Note: A D-Mount ring will screw into the T2 adaptor (both have 42mm threads). 
 

         
D-Mount 42mm outside thread, 1” inside thread for C-lenses  D-Mount with C sized lens attached 
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Prime Focus Adaptors connect the camera directly to the telescope end tube. 
Example: 2” Telescope Nose Piece with 42 mm thread adaptor. This screws into the 42mm thread on 
camera’s T-Adaptor. 
 
 

Prime Focus Adaptors with 42mm thread  
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Digital Camera Lens to CCD Camera Adaptor 
 
FotoDiox is an Illinois manufacturer of cameras adaptors, including a C-Mount Adaptor for 
various cameras. A camera lens is mounted in front (sized per camera) and a C mount thread at the 
rear to connects a CCD camera to the lens. (Shown below with a Canon EF lens attached.) 
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Barlow at 2x, 2.25x, 3x, 4x or 5x. A Barlow is placed before the eyepiece or Adaptor and it 
multiplies the magnification of the image. 
Note: A 2x Barlow doubles the magnification of the eyepiece. 

Example: 12mm eyepiece + 2x Barlow ≈ 6mm 

 
 
 
 
 
      2x Barlow for 1.25” eyepieces 
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Focal Reducer. The 0.5X Focal Reducer cuts your telescope's focal length in half. 
Sometimes needed to keep the image corners sharp (in focus). 
Note: A 0.5x Focal Reducer divides the magnification of the eyepiece. 

Example: 12mm eyepiece + 0.5x Focal Reducer ≈ 24mm 

 
 
Field Flattener with Focal Reducer. Often used to make the full image sharp (and flat) without star 
elongations on the sides. They include a 0.8x Focal Reducer - to reduce an f-7 focal ratio to f-5.6. 
Note: An M42 x .75” extension tube or spacer ring may be needed to make sure the back focus 
(distance from the back of the flattener to the sensor) matches that of the flattener/reducer (55 mm). 
Note: A 0.8x Focal Reducer also divides the magnification of the eyepiece. 

Example: 12mm eyepiece + 0.8x Focal Reducer ≈ 21.6mm 
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USB Cable used to power a USB camera and transfer the images to the computer. Different cables 
exist for USB-2, USB-3 and Connected USB (with screws). It’s best to tie down the cable to the 
camera and the telescope to get better images so that there are no unwanted movements because the 
cable dropped or slipped. 
 

     
USB-2    USB-3         Connected USB-2 Mini (w/screws) 
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Video cable with BNC or RCA Connectors 
 
Used for transferring video images from the CCD or CMOS cameras to the computer. If possible, 
use an RG59 or RG6 video cable. Some video cameras often include a very thin and “cheap” video 
cable that can cause connection and video recording problems. Heavier RG59 and RG6 cables have 
fewer connection and transfer problems. 
 
Note: With heavier RG59 and RG6 cables it’s best to tie down the cable to the camera and the 
telescope so that there are no unwanted movements because the cable dropped or slipped. 
 
2

nd
 Note: Some users like the cheaper and thinner cables because they move easily with the telescope 

(without being tied down) even though they sometimes cause connection problems. 
 

   
Video Cable with BNC Male Ends   Video Cable with RCA Ends       RG59 and RG6 Cables 
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Camera on Telescope Mount 

 
Various camera adaptors for telescopes and mounts are available. 

   
 

 
Home-made camera mount 
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Camera to Telescope Lens Adaptor – Quick-Adapt 

 
"Quick-Adapt" for connecting the camera to a 2” eyepiece. 
The top screw is an 8-32. Replace it with a 2” 8-32 screw for 1.25” eyepieces. 
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Eyepiece Projection with your DSLR Using Quick-Adapt (continued) 
 
For DSLRs, prime focus astrophotography is the prefered method (see adapter below) but for planets and other small objects, especially with short focal length 
telescopes, the image may be too small to show much detail. Eyepiece projection with the camera lens removed from the DSLR provides a lot more 
magnification for small objects.  

 

  Quick-Adapt, ZWO camera, ball-head 
 

In eyepiece projection the telescope's objective lens or mirror creates a prime focus image just in front of the eyepiece. The eyepiece collects the light from the 
prime focus image and reimages (projects) it onto the sensor in the DSLR. The effective magnification boost (M) obtained by eyepiece projection is calculated 
from the focal length of the eyepiece lens (Fe) and the distance from the eyepiece lens to the SLR sensor (Ds) as: 

M = (Ds-Fe)/Fe 
The smaller the focal length of the eyepiece (Fe) and/or the greater the distance between the eyepiece the SLR sensor (Ds) the greater 
the magnification boost from eyepiece projection. Ds can be roughly measured from where the eyepiece lens body joins it's eyepiece 
tube (the part of the eyepiece that slides into the telescope 1.25 or 2 inch draw tube) to the camera's sensor plane.  
Information from: http://rigel.datacorner.com/rigelsys/quikadapt.html 
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Color Filters and Specialty Filters 
 

  77mm Red Green and Blue Filters for B&W images – for B&W and Color images 
 

 Baader LRGB CCD Filter set – Luminance, Red, Green & Blue 
 

   #8 Light Yellow, #12 Yellow and #21 Red filters – for viewing Mars 
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 ProPlanet 642 BP IR filter – for Black & White and Color images 
 

 Seymour Solar Film Sun filter – good for Black & White images 
 

 Baader Planetarium Fringe Killer Filter 

 Astronomik CLS Light Pollution Filter 



 

Page 47 of 90 

Filter Wheels used to move filters in front of the eyepiece. Wheels can hold 4 to 8 filters. 

 Front side   Back side 

 

Pole Master for better polar alignment: Per Mike Ombrello, “The best equipment ever!” 

 
Pole Master with Connected USB-2 Mini cable (with screws) 
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Autoguiding using a Video Camera 

 

Astro-video software often includes Autoguiding. With it, a star is tracked with a camera and the 
telescope is moved to keep the star aligned. It greatly improves keeping your telescope aligned for 
long exposures. Some filter wheels have a prism lens so an Autoguider can be attached to it. 
 
An Autoguider cable is connected from the camera to the telescope's RS-232 serial controller port. 
The cable has 6 strands with RG-12 connectors (it looks like a three-line telephone cable). 

Note: Autoguiding is included in Stellarium and Cartes du Ciel. 
 
 Starlight filter wheel w/autoguider ZWO ASI174MM Mini (as Autoguider) iOptron Telescope RS-232 Autoguide Port 
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Better Star Tracking - for long exposures 
(see Appendix F: Sky & Telescope, “The Quest for Round Stars”, Ron Brecher, June 2019) 

 

1. Align all items, tightly! No Loose Parts! Make sure all items fit correctly and tightly. Tie down 
all loose cables to prevent slips which can misbalance and flex camera parts and the telescope. 
 

 
From Sky & Telescope, “The Quest for Round Stars”, Ron Brecher, June 2019 
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2. Poor Polar Alignment prevents correct tracking! Spend time to correctly align the telescope on 
the pole. Equatorial mounts often include a Polar Alignment Viewfinder. Use this to place Polaris in 
its correct position to the North Pole or the four stars for the South Pole. 
 
One way to improve the Polar Alignment on Equatorial Mounts use Pole Master. It can improve 
the telescope's polar alignment. ALT-AZ mounts do not polar align. Some alignment issues occur 
but can be corrected with better star alignments and by using an Autoguider. 
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Thanks to Terry Dufek! 
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3. Instead of a 1 star alignment use a 2 or 3 star alignment for better tracking for longer times. 
 
Elongation of stars in the image can be caused by poor tracking of the stars, as the sky revolves. 
Find the additional methods to improve the tracking on your telescope mount. 

(Yes, that means reading the manual!) 

 

 
Mounts using GPS have additional methods to improve its tracking 

iOptron AZ Pro with 32-Point GPS. “Sync to Target” improves the local GOTO accuracy to the synced star. 
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4. Balance the telescope. A poorly balance telescope may cause the motor drive to halt, move too 
slowly or too fast and create tracking errors (periodic tracking errors). 

• Place the camera, cables and all other equipment on the telescope before balancing it. 

• First balance the telescope on the declination axis. 

• Second, on the right ascension axis, move the counter weight on the shaft. 
 

 
From Sky & Telescope, “The Quest for Round Stars”, Ron Brecher, June 2019 
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5. Are items flexing out of place when the telescope is horizontal? 

 
1. Take images when the telescope is pointed up, then when it's sideways, to see if it moves out of 
place or stays correctly in place. 
 
2. If images are good when pointed straight up but bad when horizontal then you have unwanted 
movement on the telescope. 
 
3. Tighten all hardware to remove the flexing. 
 
Note: Sometimes, the focuser bends too much when horizontal. 
If that is so, replace the focuser with a stronger one. 
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6. Correctly Center the Camera - without tilting its sensor. 
 

• This is more important if the camera has a large image sensor. 

• Make sure the center of the sensor is aligned to the center of the telescope or eyepiece. 
 
 

 
Sensor Collimation 

“Cameras with large CCD and CMOS detectors are highly sensitive 
to having the sensor square to the telescope's optical axis. Some (such 
as the Starlight Xpress camera at left) include a push/pull adjustment 
plate at the front of the camera that allows users to fine-tune the 
squareness of the detector.” 
 
From Sky & Telescope, “The Quest for Round Stars”, Ron Brecher, June 2019 
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Black & White, Black & White w/Color Filters & Color Imaging 
 

It's a personal choice, B&W or Color? 
 
Color images are quick to produce. One shot (even if it’s a long one) gets the image. 
 
B&W with color filters can bring out more details but require much more time to produce. 
 

• B&W cameras produce color images by combining multiple photos, each with a color filter 
attached. One photo is taken with a Red filter, a second with the Green filter, another with the 
Blue filter and others with Luminance, Hα, O-III, S-II or IR, etc., and a black (dark) photo is 
taken which helps remove any “Hot Spots” added by the camera sensor. 

• How much time is needed? If each photo needs 60 minutes exposure, then three photos need 
180 minutes, 4 need 240 minutes, 5 need 300 minutes… This adds up quickly! 

 
Note: Color cameras produce good color images but can miss the extra details seen with Hα, O-III 
and S-II filters used on B&W cameras. 
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Colors 
 

Color temperatures in Kelvin (K) 
Spectrum Colors in nanometers (nm) 
RGB colors and Additive and/or Subtractive colors. 
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Color Designations in Photoshop and Spectrum Wavelengths 
 

 

Red 640nm  0º or 360º 

H 0 
S 100 
B 100 

L 54 
a 81 
b 70 

R 255 
G 0 
B 0 
#ff0000 

C 0 
M 99 
Y 100 
K 0 

 

Blue 440nm  240º 

H 240 
S 100 
B 54 

L 13 
a 43 
b -71 

R 0 
G 0 
B 137 
#000089 

C 100 
M 98 
Y 11 
K 12 

 

 

 

 

 

 

 

 

 

 

 

 

 

Green 540nm  120º 

H 120 
S 100 
B 100 

L 88 
a -79 
b 81 

R 0 
G 255 
B 0 
#00ff02 

C 63 
M 0 
Y 100 
K 0 

 
O-III 500nm 

H 156 
S 100 
B 84 

L 76 
a -60 
b 29 

R 0 
G 214 
B 130 
#00d682 

C 68 
M 0 
Y 70 
K 0 

 
 
 
 
 
 
 
 
 
 
 
 

 
Hα 656nm 

H 0 
S 100 
B 88 

L 48 
a 73 
b 63 

R 224 
G 0 
B 0 
#e00000 

C 6 
M 100 
Y 100 
K 1 

S-II 672nm 

H 0 
S 100 
B 49 

L 25 
a 47 
b 38 

R 124 
G 0 
B 0 
#7e0000 

C 29 
M 100 
Y 100 
K 40 

 
2 Samples: 

(from Hubble ST Cameras) 

 
93u/5306W     I336W 

f439w     439w 
f555wa     555w 
f547m     547m 
 
SN1987a     LMC Super-Nova Cluster 

x0c9101t     597s 
x0cj010bt     822s 
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Additive Colors – Red, Green, Blue, Cyan, Magenta, Yellow and White 
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Subtractive Colors – Red, Green, Blue, Brown, Purple, Tan and Black 
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Sample Image in Color and Black & White 
 

Note: More details are visible in the B&W image than in the color image. The word "Shimano" is 
clearly visible in B&W but not as visible in color. 
 

Detail of the above photo 

 
.
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Software for Capturing Images and Video 
 
1. Recording (Sharpcap or Fire Capture or Digicam) 

Note: Use 8-bit instead of 16-bit recordings and no Bayer stacking. 
 
2. Stacking (Registax, AutoStakkert, Deep Sky Stacker or others such as live stacking with 
Sharpcap) 
3. Enhancing images (Registax, Photoshop or Lightroom) 
4. Post editing (Registax, Photoshop, Lightroom, RGB Color designation, Sharpening and High 
Dynamic Resolution - HDR) 
5. FITS (Sharpcap, Fire Capture or Photoshop FITS Liberator) for full frame images and 
improvements on some images. 

(see Appendix B: “Create your own Color Hubble Images”, Zolt Leva) 
 
NASA FITS: http://hla.stsci.edu 
 
Best Images From the Hubble ST cameras: 
WFPC2 Wide Field and Planetary Camera 2 
WFC3 Wide Field Camera 3 
ACS Advanced Camera for Surveys 
Narrowband Filters Used: F435W, F439W, F450W, F555W, F606W, F675W, F702W, F791W, F814W 
Wideband used Filters Used: F437N and F502N (O-III), F656N (H-Alpha), F658N (N-II), F673N (S-II) 
 
FITS Viewer  
http://fits.gsfc.nasa.gov/fits_viewer.html 
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NASA FITS (continued) 

 
FITS Libraries 
http://fits.gsfc.nasa.gov/fits_libraries.html 
http://www.cv.nrao.edu/fits/ 
samples: 
http://www.cv.nrao.edu/fits/data/samples/hst/ 
 
Image Processing Resources for Astronomy Teaching 
http://www.phy.duke.edu/~kolena/imagepro.html 
 
FITS Liberator 
http://www.spacetelescope.org/projects/fits_liberator/ 
 
M51 Site 
http://www.spacetelescope.org/images/heic0506a/ 
 
Band Wavelength Telescope 
Optical B 435nm Hubble Space Telescope ACS 
Optical V 555nm Hubble Space Telescope ACS 
Optical H-alpha + Nii 658nm Hubble Space Telescope ACS 
Infrared I 814nm Hubble Space Telescope ACS 

 
 
Note: Magazines are available on Astrophotography: (example) 
https://www.amateurastrophotography.com/magazine  
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FITS Program viewing the Hubble Deep Field 
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Techniques for Eclipses, Northern Lights & "Quick" Events 
 
 
 
 
 
 
 
 
 
 
 
 

 

Transit of Venus from Jabiru, Kakadu National Park, Australia 
06 June 2012 Local Jabiru Time 
1st Contact 7:46:40:06 am 
2nd Contact 8:04:44:03 am 
3rd Contact 1:58:10:53 pm 
4th Contact 2:15:28:15 pm 

       Roy observing transit with beautiful weather. 
       Nothing is too dangerous for PAC members! 
       (Note the crocodiles wanting to visit Roy...) 
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Lunar Eclipses allow you more time for your photographs. Take photos every few minutes. 
 

Camera Settings for a Lunar Eclipse - Times in Seconds with f-numbers 

Event ASA 100 ASA200 ASA 400 ASA 800 

Full Moon 1/250 f/11 1/250 f/16 1/250 f/22 1/500 f/22 

Penumbra Shadow 1/60 f/11 1/60 f/16 1/125 f/16 1/250 f/16 

2nd and 3rd contact 1 f/2.8 1 f/4 1/4 f/2.8 1/8 f/2.8 

Totality 2 f/2 2 f/2.8 1 f/2.8 1/2 f/2.8 

 

Solar Eclipses are quick! So practice setting everything up and take practice photographs. You only 
have a few seconds before the eclipse is gone. Remove your solar filters during the full eclipse to 
image the corona but be sure to not view through the telescope or camera when the sun emerges or 
you will permanently damage your eyes! Replace the solar filter for the rest of the solar eclipse. 
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Northern Lights or Aurora Borealis 

• Dark areas are best for to see and photograph the northern lights. 

• Set your camera on a tripod and take long exposures of 30 seconds to several minutes. 

• Keep the ISO setting low (ISO-50 to ISO-800) and increase it only if you cannot get enough 
detail. 

 
 

 
 

Taken in Norway above the Arctic Circle, December 2013, Sylvia Roba 
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Urban Photography Problems and Some Solutions 
 
Light Pollution Filters, Urban Filters and others 

• Broadband filters keep bad light out and let good light in. They are best for viewing galaxies 
and star clusters whose own light spans the entire visible spectrum. 

• Narrowband filters aggressively block light pollution, but dim star clusters and galaxies. The 
filters are for spectral bands such as hydrogen and oxygen emissions. They are both light-
pollution and nebula filters. 

• Light-pollution filters block the colors emitted by older streetlights and transmit light from 
objects in the sky. 

• Oxygen-III filters transmit only a narrow slice of the spectrum for oxygen ions emitting a 
greenish light. They enhance planetary nebulae and a few supernova remnants. 

• Hydrogen-beta filters transmit one blue-green emission line from hydrogen atoms. They are 
optimal for extremely faint targets, i.e. the California Nebula, IC 434 and the hydrogen gas in 
the Horsehead Nebula. 

 
The trouble with the new LED Lights 

The new LED lights appearing in cities usually are “Blue” in color - about 5000-K - and may 
prevent light pollution filters from working. There are other LED lights with better colors – “soft 
white” at 3200-K – but manufacturers have been using 5000-K lights and many never change. Try to 
find areas where the majority of the light is blocked by buildings, fences, etc. 
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next 

 

Part 2: Planetary and Deep Sky photography - Terry Dufek 

 

 

then 

 

Part 3: R2 demonstration - Rusty Case 

 

 

 

 

Finally… 

 

Time to Answer Your Questions! 
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Appendix A: “Using Firecapture”, Terry Dufek 
 

USING FIRECAPTURE (TIPS) 
• Set up capture folder 

• Save default camera settings (if needed) 

• Center object in the view screen for the appropriate resolution used. 

• Use Region of Interest (ROI) to reduce file size for faster processing 

• Set up gain and exposure (review histogram until it is about 60 - 70% BUT try to get 80-90%) 

• Frame rate should be low 90 – 100 fps 

• USB set at about 80 (under more settings) 

• Time of exposure 1 ½ minutes (8000 frames) Jupiter 

• Set gamma about 50 (or try turning gamma off) 

• Set camera profile settings 

• Set camera filter settings (?) 

• Set length of time of exposure 

• Set video type (AVI or SER) most common types – uncompressed 

• Set auto align 

• Set up crop to cut down excess video recording 

• Debayer unchecked (checked will show you a color version) 

• Then check color balance levels before unchecking debayer 

• RESTORE or SAVE camera settings is under control/ more (side arrow down) 

CAPTURE SECRETS 
• Find the sweet spot of your imaging system.  Have a capture routine for each target object.  

• Make sure your filename includes the UT date and time. Use the fastest frame rate possible.  

• Don’t be afraid to push gain to Don’t be afraid to push gain to 100%.  

• Turn off Gamma!!  

• Spend time to focus the telescope.  

• Use Region of Interest (ROI) to reduce file size for faster processing. 
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JUPITER 
• Keep histogram level around 80 to 90% on all channels.  

• Keep total integration time below 2 minutes.  

• Use focal length of around 30X of your aperture 5-micron pixel your aperture 5 micron pixel cameras and 20X the aperture for 3.75 

micron cameras. 

SATURN 
• Saturn has very low surface brightness. 

• Use Winjupos Derotation so that the final image will be smooth. 

• Use 50% histogram level for red and green and 30% for blue.  

• Keep total integration time to around 3 minutes. 

•  

MARS 
• Use focal length around 50X  the aperture for 5 micron pixel cameras and 30X the aperture for 3.75 micron cameras.  

• Keep histogram level of the Red Channel at around 8090%.  

• Keep Green at around 90%.   

• Keep Green at around 60-70% and Blue around 30 - 40%.  

• Total integration time can be as long as 4 minutes.  

• UV-IR should be blocked to get true colors.  Make sure your blue channel has no IR leakage. 

 

Website for Firecapture: 
http://www.firecapture.de/’ 
 
The tutorial videos take a while to go through but #2 is where he [the author] uses the program: 
https://www.youtube.com/watch?v=DJ1SpbCmM9U&t=21s  
 
Terry Dufek 
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Appendix B: Create your own Color Hubble Images, Zolt Leva 

Create your own Color Hubble Images 

Zolt Levay, Office of Public Outreach 

Until recently, making presentable images from Hubble data has been fairly cumbersome, requiring some experience with specialized 
software such as IRAF or IDL, used to analyze astronomy data. Now the process has been significantly streamlined with the 
introduction of the Photoshop FITS Liberator. If you have a basic understanding of astronomical data, digital photography and a 
working knowledge of Adobe Photoshop you can transform astronomical data in the FITS format into pretty pictures, in black and 
white or in color. The resulting images may be used as any digital photo: reproduced in print, displayed on a web page, emailed, etc. 

FITS, the Flexible Image Transport System is a file format used for many years in astronomy to store and move images from 
telescope-based instruments. It has been designed to provide capabilities needed by 
astronomers but is not a generally known format such as JPEG or TIFF.  

Adobe Photoshop is the industry-standard “digital darkroom” software for working with 
photos. It includes many tools to work with images to improve tonal range, color, 
contrast, in addition to combining multiple exposures, adding annotation, and a whole 
suite of more artistic capabilities. But Photoshop has not recognized FITS data, until 
now. 

The Software 

The primary tool in the process is a software plugin to Adobe Photoshop called the FITS 
Liberator. This free software was developed by the European Space Agency (ESA), European Southern Observatory (ESO) and the 
National Aeronautics and Space Administration (NASA) and is available for free download from ESA along with instructions for the 
simple installation, sample data, and much more information. See this page in our Content Creator’s Toolbox for more information. 
 
The plugin is available for PC/Windows and Mac systems and works identically on both. It provides full functionality with Photoshop 
CS (also known as version 8.0) but it also works with Photoshop version 7.0 as well as Photoshop Elements versions 3.0 and 2.0, with 
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more limited functionality. 
 
After installing the plugin, Photoshop recognizes FITS files as a known, native format. To begin, start Photoshop and open a FITS 
image using the File > Open (keyboard shortcut: CTRL/CMD+O). You will see the FITS Liberator dialog: 
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The main components of the dialog are: 

• The preview window at uper left shows a representation of the image as it will appear once opened in Photoshop. The image 
initially is sized to fit entirely within the window but the "+" and "-" buttons below may be used to zoom in and out.  In 
addition, clicking and dragging within the window will pan a zoomed image. 

 

• A “histogram” below plots the number of pixels of each data value in the image. 

 

• Sliders and numeric input to specify the range of data values to import. 

 

• A menu of the available image planes/extensions, if applicable to the FITS data.  
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• Image statistics include image size, minimum and maximum data value, etc. Moving the pointer within the display window 
shows the location and value of the pixel at the pointer's location. 

 

• The “stretch function” specifies how the image data values should be transformed into pixel values in the Photoshop 
document. Selections are: linear, log, square root, sqrt(log) and log(log). 
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• Various switches control other functionality: whether to use 8-bit or 16-bit channels in the Photoshop document, whether to 
translate FITS null values to black or transparent pixels, whether to show the image preview, how to preview out-of-range 
pixels, and how to display the histogram. 

The Data: Obtaining FITS Images 

The FITS Liberator will accept valid FITS data from any source. Several sample datasets from various sources are available from the 
European Space Agency. 

Data from Hubble Space Telescope and several other missions are available from the Multimission Archive at Space Telescope 
(MAST) . Because of the size and complexity of the archive and the data, only a very brief introduction will be given here. Various 
tools are available for searching and retrieving data from the extensive collections, from a very comprehensive cross-mission search, 
to more directed search by specific mission, coordinate, instrument, etc., or more sophisticated searches by pointings (HST only), 
scrapbook , etc. For a limited set of observations, initial processing has been performed to produce High-Level Science Products more 
suitable for display and analysis than individual datasets. 

Once the desired observations are identified, datasets may be retrieved from the archive, made available via anonymous ftp 
(alternately, you may register as an archive user). Complete instructions and tutorials are online and help is available via email. 

Be aware that HST image datasets are quite large, and observation sets generally include numerous exposures. Be prepared with 
plenty of disk space and RAM. A single HST ACS/WFC exposure from the archive is a 170MB FITS file. A single WFPC2 exposure 
is 10MB. Many HST datasets available from MAST can be used as-is. In some cases, "on-the-fly" processing (OTF) combines 
associated datasets into a single image. Others require more extensive processing after retrieval to produce useable data. 



 

Page 77 of 90 
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The Process: Making a Black & White Image 

The key element in producing presentable images from data is how to scale the image from the pixel values in the input file into 
values in the image that are displayed as a range of gray brightness levels. This is accomplished by selecting the range of input values 
and specifying the function to transform the input data into displayed pixel values. Astronomical images tend to include a very large 
range of brightness levels, from the very dark sky background to much brighter stars, galaxy nuclei, etc. Often small numbers of pixels 
have values well outside the usual range. "Dead" detector elements or other causes can result in values of zero or much less than the 
normal sky background. Cosmic rays can produce much higher counts than moderately bright stars. Using a data range including the 
minimum and maximum data values often does not produce a very exciting image. Although celestial objects appear very dim in the 
sky to our eyes, long exposures with sensitive detectors on large telescopes yield a large range of numerical values in the resulting 
images (technically referred to as large dynamic range, made possible by image formats with high bit-depth). 

Select the function from the “stretch function” menu. 

 

 

 

In many cases, log scaling provides the best results for astronomical images. This conveniently serves to enhance contrast and bring 
out details in the darker areas of the image, where the interesting stuff often goes on in astronomical images. In addition, it suppresses 
the much brighter areas such as the centers of stars, where the detail is not so critical. Sometimes square root (sqrt) stretch works 
better for certain types of images. Try different functions to see which result appears more pleasing in the preview. 
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FITS Liberator will select an initial data range based on the distribution of data values, but will most likely not produce the best 
image. Adjust the data range using either the sliders under the histogram plot or the numeric input values labeled “Black level” and 
“White level”. You will see the result in the preview display. As you increase the black level the image will darken overall and whole 
areas will become black (clipped). If the “Black clipping” check box is selected those pixels whose value is smaller than the black 
level will show as blue in the preview but will become black in the Photoshop document. Conversely, as you decrease the white level, 
the image will brighten overall and more pixels will become white (saturated). If the “White clipping” check box is selected the pixels 
whose value is greater than the white level will show as green in the preview and will become white in the Photoshop document. You 
can experiment with the data range to achieve a pleasing result. 

 

By paying attention to the out-of-range indicators in the image preview, it is possible to scale the image such that the background 
(shadows, in photo terminology) is dark, but not completely clipped and the brightest areas (highlights) are not saturated or rendered 
totally white. 

Select whether to scale the data to 8-bit or 16-bit pixels in Photoshop. 

 

The advantage of using 16-bits/pixel channels is that there are many more gray levels available. The disadvantage is that it makes the 
resulting image files twice as large in disk storage. Having more gray levels available means that you can adjust the image a great 
deal.  

When you are satisfied with the result, click “OK” to accept the image as adjusted and read the image into a black and white (gray) 
Photoshop document. Note that there is no provision for automatically recording the settings, so you may wish to write down the 
scaling function and black and white levels. The result will be a gray image in a Photoshop document window: 
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Photoshop Adjustments 

Once the image is in Photoshop, a vast suite of tools is available to adjust and manipulate the image. Perhaps the most useful of these 
are the “levels” and “curves” adjustments. Levels (Image > Adjustments > Levels or CTRL/CMD-L) allows you to adjust the 
brightness and contrast of the image overall by specifying the minimum data value to assign black and the maximum data value to 
assign white (similar to the black and white levels in the FITS Liberator).  In addition, it permits an intermediate adjustment 
(sometimes referred to as “gamma”) that changes the functional transformation between the pixel values and displayed pixel 
brightness (something like the selection of the stretch function in the Liberator but with continuous variation rather than fixed 
functions). 
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Curves (Image > Adjustments > Curves or CTRL/CMD-M) permits much more flexible changes to the brightness and contrast of the 
image with a graphical representation of an arbitrary transform function. 

 

Note that it is usually preferable to apply adjustments as an "adjustment layer" rather than modifying the image layer directly. Create 
an adjustment layer using Layer > New Adjustment Layer or the New Adjustment icon on the Layers Palette. 

A further refinement is to apply adjustments only to areas that need it. For example, you can brighten fainter regions without blocking 
up (saturating) brighter areas by applying a mask to the adjustment, if it is applied using an adjustment layer. Paint in the layer mask 
with black to prevent the adjustment from applying. 

The goal of such adjustments is an image with a more balanced range of tones, from black to white, making visible those features in 
the data that are of most interest. For example, a well-crafted curves adjustment can enhance relatively faint outer arms of a galaxy 
without saturating brighter areas near the nucleus. 
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Save your work. If you save as a Photoshop document all features will be available for recovering and modifying again, including full 
16-bit image layers, adjustment layers, masks, etc. 

The Next Step: Making a Color Composite 

A more sophisticated exercise is to combine multiple exposures into a color composite. Registered exposures of the same object made 
using different color filters may be used to reconstruct a color image. In general the colors will not be “real” as in what we would see 
visually.  But the colors do represent actual physical properties of the subject. The basic idea is to combine the images using 
Photoshop's "layers" which permits multiple images to be combined in a single document. There are various ways to combine the 
images; the most flexible is to put the separate images in separate layers and colorize each. This method permits adjusting the hue 
more or less arbitrarily, combining two or more images, and applying numerous adjustments to each gray image separately. 

In this case we will "colorize" the image by applying a different hue to each layer, making use of the "additive" color model, in which 
varying intensities of the primary hues red, green and blue add together to produce the range of all possible visible colors. This is 
accomplished by "projecting" each layer onto the virtual screen of a displayed image using Photoshop's "Screen layer blend" mode. 

To begin, open each image as a gray Photoshop document using the FITS Liberator. Copy each to a separate layer by dragging and 
dropping each in one of the documents. Note that if you hold down the Shift key while dropping, the dropped image will be centered 
in the existing document. It's best if the images are registered (the features in all the images line up pixel for pixel) beforehand, which 
may be done using external software. However it is possible to register them manually in Photoshop, but that's a little beyond this 
exercise. The Photoshop "Layers Palette" will graphically show the order of layers in the document. 
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(Note that you can assign a color and name to each layer using the "Layer properties". In this case, the name (the text to the right of 
each thumbnail) was used to identify the source of each image. The color has nothing to do with the color applied to the image pixels 
but serves only to further label and identify the layer.) 

Convert the grayscale document to RGB color: Image > Mode > RGB Color , select Don't Merge when asked. Set the "layer blend 
mode" of each layer to "Screen" using the drop-down menu in the Layers palette or Layer > Layer Style > Blending Options...: 

 

To colorize each layer use "Hue/Saturation" adjustment, preferably using an adjustment layer (Layer > New Adjustment Layer > 
Hue/Saturation...). 
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Select the "Hue" of the layer to convert the gray image to a color layer. The numerical hue values correspond to angles around a color 
wheel: 0 is red, 60 is yellow, 120 is green, 108 is cyan, 240 is blue, 300 is magenta, and intermediate values result in intermediate 
colors. Make sure the "Colorize" box is checked, set "Saturation" to 100 and "Lightness" to -50. This will ensure that the colors for 
that layer will range from black (for 0 pixel value) to the brightest possible value of the given hue (for the maximum pixel value, 255 
for 8-bit channels). Finally, to apply the Hue/Saturation adjustement only to the appropriate image layer, "Group" the Hue/Saturation 
colorize layer with the corresponding pixel layer by highlighting the adjustment layer and using the menu Layer > Create Clipping 
Mask (or CTRL/CMD-G on the keyboard). 

     

Note that applying the "additive primaries" red, green and blue to three layers provides the broadest range of colors in the final 
image.You may certainly use any combination of these, but the range of possibilities is seemingly endless. The values suggested here 
result in the most predictable results and the widest range of reproduced colors. In the example above we have used the colorize values 
as described above and have inserted a descriptive Layer Name to make note of the intent of each. 
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In general the resulting color composite is not very sastisfying, appearing dull, or having a particular color cast. Again, you can apply 
any of the numerous Photoshop adjustmets to improve brightness, contrast, color, etc., just as with any digital photo. Adjustments may 
be applied to each gray image layer by inserting a Levels, Curves, etc. adjustment layer between the image layer and its corresponding 
Hue/Saturation colorize adjustment layer. In addition, you may adjust the composite as a whole by inserting adjustment layers above 
all of the image and adjustment layers. 

       

Again, save your work, and don't forget to save often; you never know when a system crash or other disaster may strike. 
http://hubblesource.stsci.edu/services/articles/2005-02-10/ Hubble Legacy Archive http://hla.stsci.edu 
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Appendix C: AL Reflector, “Three Cheers for the Photosphere”, Jim Daley, Dec 2017 
 

ZWO ASI-120 Imaging and Processing 

 

The principal imaging detector is a ZWOASI120MM CMOS fast (monochrome) framing camera. The angular field of each 
pixel is 0.165 arc seconds, thus well oversampled for maximum possible resolution. AVI video files are captured with Sharp Cap 2.9 
and video frame stacking is performed with Auto Stakkert! Final image enhancement is done in RegiStax6 using wavelet processing. 
These programs are all free Internet down loads. 

The typical frame rate for roughly 60-arcsecond fields (380 x 380pixels) is 58 frames per second and typical exposure times 
run about 340 microseconds, which completely “freezes” the atmospheric seeing. Because of various seeing phenomena, including 
coherence of seeing (which is a frame-to-frame, turbulence-caused image distortion that is mostly correctable in Auto Stakkert! and 
which increases in harmfulness with greater field angles), this frame size is the one most used in my observations. 

It is vital in this type of solar work to operate from a darkened room (you must be comfortably seated and see the computer 
screen perfectly). My observatory has a small attached computer room to the north where the camera’s USB cable leads from the 
telescope, through the wall and directly to the laptop. For high-speed video the cable is necessarily short and some thought must be 
given to the layout to allow at least a few hours of observation without cable tug disturbing the telescope pointing. 

Operationally, I begin an observing run by judging the image quality (and setting the telescope focus) of the free-running video 
on my Dell laptop. As powerful as LI is, good seeing is still very important. It is also important to open the histogram feature and set 
the exposure to about 60 percent full-well (avoiding saturation at the upper limit). The capture program allows you to set the gamma 
or contrast value (1to 100). I usually set it at about 40. 

One soon senses the cadence of the seeing and learns to start a recording at the best moments. Recording can be stopped and 
captured any time the seeing “blows up” or wind induced angle jitter becomes excessive. Typically, four really good videos (an 
eyeball estimate) of at least 20 seconds duration are selected for processing from the 25 or so recorded during an observing run. The 
best video frames from each good recording are computer selected (in Auto Stakkert!) by a contrast algorithm and presented in 
descending order of quality. I use the percent quality value feature to decide the number, where 100 percent is (relatively) the best. I 
usually cut the number of frames at 90 percent quality and use the displayed value of frames within these bounds to stack. Some 
videos provide only five or six good frames meeting the aforementioned criteria, while others, under great seeing, can yield up to 200 
sharp frames, yet the final (after wavelet sharpening in RegiStax) results are sometimes rather similar! 
 
From the Astronomical League magazine Reflector, “Three Cheers for the Photosphere”, Jim Daley, December 2017, pages 20-21 
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Appendix D: AL Reflector, “Basic Small-Scope Lunar Imaging”, Jamey L. Jenkins, March 2019 
 

 Pages 14 to19 
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Appendix E: PAC Reflections, “A solar report from Ken Boquist on March 16th, 2019”, April 2019 
 

Member Observations (written, visual or photographic welcome) 
 
A solar report from Ken Boquist on March 16th, 2019:  
Today was a pretty good day for imaging the sun, being clear late morning, and also a nice deep blue sky. About a week 
or two ago I saw an article somewhere that discussed whether the Sun was now starting to come out of a solar minimum. 
I think this might be the case, as I finally saw a filament that actually had pretty high contrast and stood out well. There 
were a couple of prominences, but they were extremely faint, and never im-aged well, so I didn’t retain any pics of the 
prominences.  
I started out the morning using my Canon Rebel DSLR like I have always used in the past. The pic that says Canon Rebel 
is the pic in question. This pic was slightly pro-cessed using MS Picture Manager. It shows the filament in question, along 
with a plague and a much smaller filament to the lower right of the prominent one. This pic is fairly similar in quality to 
what I have been able to achieve in the past.  
I then took some pics using a new Mallincam (the DS287m SkyRaider) that I bought. This is a small CMOS video camera. 
It is not the one that I used for the deep sky pictures that I have been sending the last couple of months. The other two 
pics show the end result of what happened with that camera (they both have the name “DS287” in the file name). I 
thought the camera took far superior images compared to the DSLR. I think the whole disk picture clearly shows more fine 
detail in the solar granulation. The closeup pic was, I thought, really good!  
What’s really interesting about this camera is just how fast it is. With the DSLR, I always had to use an ISO of 1600 to 
keep the exposures to a reasonable duration, which gen-erally has been around 1/8th to ½ seconds. With the DS287, I 
was using exposures of only about 1 to 20 milliseconds, and this was with a very low gain of anywhere of 1 to 5 on a scale 
of 1 to 50 on the whole disk images. The camera happens to be quite inexpensive compared to a DSLR, and yet it took 
some very good picture. Needless to say, this really kept noise to a minimum.  
Anyway, I thought you might be in-terested in seeing the difference be-tween a general purpose DSLR ver-sus a camera 
designed specifically for astronomical applications. It looks like I’ll probably take all of my future pics with the Mallincam.  
Ken Boquist  
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Appendix F: Sky & Telescope, “The Quest for Round Stars”, Ron Brecher, June 2019 
 
 

 Sky & Telescope, June 2019, pgs 64-67 


